
PMS RentalReady Releases 02.2026
(February)

General
Product Updates Visibility & Notifications

What’s changed:

A blue notification badge now appears on the Product updates sidebar option when a new

release is posted.

On the RentalReady Home page, the ReleaseNotes banner has been moved one level higher to

make updates easier to notice.
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Reservation
Reservation history small improvement

Before, we did not show the Guest Total to pay and Reporting commission in the history for the

reservation. Now, we show it.

Pricing
1. Single Units Rate Plans

You can now create Rate plans for Single Units (not only Multi-Units).

Supported Rate Plans:

Breakfast: +X per person / per night

Non-Refundable: -X% discount

2. Extra Fee invoices now generated at CO+1 - only when split is NOT allowed

Extra Fee invoices are now included in the CO+1 day generation for offices not using our split

system, so all invoices appear promptly in the Owner Space.

Now

All invoices, including Extra Fees, are generated 1 day after check-out 

Invoices are visible immediately in the Owner Space → Transactions tab.

Owner
1. Owner space - Property tab now respects Reviews permission settings
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The property reviews tab now enforces the same permissions as the welcome page:

With only "show guests' ratings and reviews" enabled, owners see ratings and public reviews

only.

Adding "Owners can see replies to reviews" makes the reply section visible.

Adding "Can see full reviews in host space" shows criteria ratings, private feedback, and the

full review modal.

2. Owner Permissions: Calendar & Configuration

We’ve introduced new permissions to better control what Owners can manage directly from the

calendar:

Block and unblock dates

See financials details in Inline Calendar

Edit minimum stay directly from the calendar

Property
1. Property layout form update

We have updated the property layout form to improve room configuration. These updates also

apply to Rental Onboarding and Multi-Unit Onboarding.

What’s new?

The Layout tab in property form has been renamed Property layout

Bedrooms are now called Sleeping arrangements and can include bedrooms with beds and

living-rooms with beds

Sleeping arrangement and bathroom forms now open in a side panel for a more focused editing

You can now add additional room types (e.g., office, garage, storage, living room without beds)

Sleeping arrangements and other room types can have their own amenities

Sleeping arrangements now include a Baby crib toggle and a field for the number of baby cribs.

Enabling the toggle automatically adds the baby crib amenity to the room

Bathrooms now require selecting their privacy, between Private, Shared and Ensuite. If marked

as Ensuite, the bathroom must be linked to a specific sleeping arrangement
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2. Property quality score

We’ve made some performance improvements on the property quality score table, it should load

more quickly now.

Channel manager
Emojis are not allowed on Airbnb Listing Expectations

To prevent sync issues with Airbnb, emojis are no longer allowed in Listing Expectations.
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Inline Calendar
1. Inline calendar - bug fixes.

In the last few days, we had some bugs in the inline calendar. All the bugs came from the horizontal

scrollbar.

The built-in calendar uses an external library that uses a scrolling method that is not convenient for

us. When we tried to adjust the way it scrolled, the smoothness was lost, the timeline often didn't

follow the scroll, and in some cases, after using the scrollbar, some reservations shifted out of

position on the timeline.

We managed to fix the scrolling so it works properly when using the header (with the dates),

dragging the timeline with the mouse, or using the mouse wheel.

Unfortunately, the scrollbar's functionality cannot be changed, so it was decided to hide it (it was

hidden in the past too).

If you want to scroll without the mouse wheel, you can drag the timeline or the header!

2. Daily price permission for inline calendar

Users without the permission “Can see the daily prices in host space” are no longer able to see

daily prices & minimum stay in the inline calendar. The options “Show empty cell” / “Show price per

night” and “Show min. stay” are also not displayed for these owners. This change was made to

align the behaviour of the inline calendar with the behaviour of the property calendar.
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3. Inline calendar in agent mobile app

The inline calendar is now available in the agent mobile app for agents who have the permission

“Can see inline calendar”

Artificial Intelligence
1. Maia reply delay

The delay with which Maia replies to messages can now be set in the mailbox assistant

configuration

Previously, the default delay was 120 seconds and it could be customised via the back-end

Now, the default delay is 0 seconds and it can be customised by customers themselves
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2. Maia UI Update — “Training” Renamed to “Testing”

We’ve updated the terminology used in Maia to reduce confusion and better reflect how the system

actually works.

What changed

All instances of “Training” have been renamed to “Testing”

Applied across:

Mailbox Assistant Maia

Ticket Assistant Maia

Audit tabs (where applicable)

A few other small UI improvements

3. Maia — Preapprove and Reply to Inquiries Based on Minimum Advance Time
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We’ve updated Maia’s inquiry handling logic to align with the configured minimum advance time at

rental level.

Before

Maia would not reply to inquiries if the check-in was the same day and the inquiry was not

already pre-approved

Maia would not pre-approve inquiries for same-day or next-day check-ins (hardcoded logic)

Now

Maia evaluates inquiries based on the configured minimum advance time (at rental level)

Maia can respond to and pre-approve inquiries (even if not previously pre-approved) as long as

they respect the defined advance time

If an inquiry does not meet the minimum advance time requirement, Maia skips processing it

entirely

Example

If the minimum advance time is 24h and an inquiry is not pre-approved:

If the guest reaches out 24h or more before check-in → Maia can reply and pre-approve

If the guest reaches out less than 24h before check-in → Maia leaves it to staff

Note: If the inquiry is already pre-approved, Maia can reply without restrictions.

Offices
Offices action button improvements

We have updated the action buttons from the Offices index page. The buttons are reordered and

some of them have been renamed:

Manage pricing algorithms -> Pricing tool
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Price settings -> Pricing

Manage extra fees rules -> Extra fee rules

Property onboarding form configuration -> Property onboarding form

Set highly suggested amenities -> Highly suggested amenities

Set mandatory amenities -> Mandatory amenities

Edit conversation flags -> Conversation flags

Maia Configuration -> Mailbox assistant Maia

Edit custom reservation risk criteria weights/Manage custom reservation risk criteria weights ->

Reservation risk criteria

Missions
1. Default Settings for Extra Missions in Rental Form

What’s changed:

A new “Extra missions” section is now available in the Rental Form (Property Edit → Missions

tab), displayed after the “Check-out missions” section.

Users can configure optional default values for Extra missions:

Permanent internal comment

Permanent external comment

Default agent

These defaults behave exactly like the existing defaults for Cleaning and Check-in missions and

are automatically applied to all future Extra missions created for the rental.

2. Weekly Mission View: Redesigned & Refined

We’ve overhauled the Weekly Mission View to give you a sleeker, more intuitive experience. 
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Here’s what’s new: Enhanced Mission Cells

Information Hierarchy: We’ve reordered the data within cells for better readability.

Fresh Design: A modern look and feel for every mission block.

Completion Tracking: A new Checkmark Icon  now clearly indicates when a mission is done.

Customize view

Hide property name: You now have the option to completely hide property names for a more

minimal interface.

Updated Labels: We’ve renamed the previous views to be more descriptive, though the core

functionality remains exactly as you know it.

Superior Responsiveness 

The experience is now fully optimized for small and medium screens with a mobile-first approach:

Smart Filters: The filter button has been redesigned, and filters now open in a convenient off-

canvas menu.

Tabbed Layout: Say goodbye to cramped tables! Missions are now organized into daily tabs for

easy navigation.

Focused Details: Selecting a cell opens mission details in a smooth off-canvas tray.

Simplified Experience: To ensure a clutter-free experience on smaller screens, the layout is set

to a single Cell View (view switching is disabled on mobile).
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3. Mission Navigation Tab

What’s changed:

Introduced tab navigation on the Mission Details page, which now includes Mission Details and

Checklist tabs.

The Checklist tab contains the Checklist Result page.
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4. Renamed Options in the Nested Checklist Button on the Mission Details Page

What’s changed:

The options within the nested Checklist button on the Mission Details page have been renamed for

better clarity:

View checklist → Fill in checklist

Add extra checklist steps → Add a task to checklist

Checklist results → Show checklist

5. Checklist Result Page – Design Update

We’ve updated the design and layout of the Checklist Result page to improve clarity, structure, and

overall user experience.

What changed? 

Layout Improvements

Checklist metadata has been moved from the right panel to the top section.

A new Checklist/Mission summary is now displayed at the top.

Mission incidents are visible in the top section and the right panel.

Categories and their answers are now better visually separated.

Button & Navigation Updates

• Removed the “Checklist” button from the top section on the Mission Details page.

• All related actions are now located on the Checklist page in the Actions section.

• Some buttons were renamed for clarity: View checklist  → Fill in checklist Add extra checklist steps  →
Edit checklist tasks Open a ticket   → Create a ticket Copy to property pictures  → Duplicate pictures to

property Minor UI Improvements

The submission date and username are now shown in a tooltip under the badge at the end of

each step.
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If a step was not required and no answer was submitted, “Skipped” will be displayed at the end

of that step.

Yes/No answers are now displayed at the end of each step in a colored badge: Green/Red.
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6. Weekly Mission View Updates

We’ve refreshed the design of the detail cards in the Weekly Mission View:

The overall design is now more modern.

Internal and external comments are now integrated directly into the Mission Details card.

The Platform Details card has been merged with the Reservation Details card.

In Check-in and Check-out missions (where reservation details are shown), we’ve added tabs

so you can quickly choose which details to view—without needing to scroll down.

7. Checklist Result Page – Functional Changes Important functional updates to the Checklist

Result page

This release introduces behavioral changes that may affect how you use the page. Detailed Step

Instructions Removed

We no longer display detailed step instructions on the Checklist Result page.

Only the main question title is now shown.

Detailed step instructions are still available when you click “Fill in checklist”.Please keep this in

mind when reviewing checklist results. Dynamic Actions Based on StatusThe right-side Actions

panel now displays available actions dynamically, depending on the Mission and Checklist status:

• Mission: To Do + Checklist: Not yet filled → Edit checklist tasks, Fill in checklist

• Mission: In Progress + Checklist: Started → Edit checklist tasks (disabled), Fill in checklist

• Mission: Done + Checklist: Submitted → Mark as reviewed, Fill in checklist, Create a ticket,

Download all pictures, Duplicate pictures to property, Edit checklist tasks (disabled)
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• Mission: Done + Checklist: Reviewed → Fill in checklist, Create a ticket, Download all pictures,

Duplicate pictures to property, Edit checklist tasks (disabled) New “More actions” Menu We added

a new “More actions” button, which includes:

Download all pictures

Duplicate pictures to property

Edit checklist tasks

Conditional Display in Mission Section (Right Panel)

Agent, Ticket, and Reservation are now displayed in the Mission section (right panel) only if

they exist.

If they are not linked to the mission, they will not be shown. Please review these changes carefully,

especially if you regularly work with checklist results.If anything is unclear or behaves

unexpectedly, please let us know

8. Checklist Result Page – PDF Export

You can now export the Checklist Result as a PDF. A new “Export PDF” button has been added to

the Actions section on the Checklist Result page.

File Naming: The downloaded file will follow this format: DD_MM_YYYY_Property PropertyID_MissionType 

MissionID.pdf Example:  22_02_2026_Property 3544_Cleaning 243214.pdf

What the PDF Includes:

• PM logo

• Property link

• Property address

• Incident (if reported):

Displayed in the top section

Included again in a separate Incident section at the end of the file
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Categories with their steps and answers: displayed in the same structure as on the web page

What the PDF Does NOT Include

Submission details (who submitted and when)

Checklist metadata (when started, who filled it in, duration)

Connection to a ticket

Checklist status

How It Works: When you click the “Export PDF” button, a request is sent to generate the PDF. You

will see a confirmation message in the bottom-right corner of the screen. The PDF is generated

asynchronously. Within a few seconds (or minutes, depending on the number of attachments in the

checklist result), you will receive an email with a link to download the prepared PDF. AvailabilityPDF

export is available only for Missions with:

Mission status: Done

Checklist status: Submitted or Reviewed

The “Export PDF” button will only be visible for missions that meet these conditions.

9. Checklist Results page - Bulk PDF Export

You can now export multiple Checklist results in a single export.

How it works: On the Checklist Results page, you can select multiple checklists using the checkbox

at the beginning of each row. Once at least one checklist is selected, the "Export checklist PDFs"

button will appear next to the "Export CSV" button. After clicking "Export checklist PDFs", a request

to generate the PDFs will be sent, and you’ll see a confirmation message.

Within a few seconds (or minutes, depending on the number of selected checklists and their

attachments), you will receive an email with a download link. The download link will contain a ZIP

file with separate PDF files for each checklist result (just like exporting a single checklist result).

Please note:

• The "Export checklist PDFs" button appears only after at least one checklist is selected.

• Only checklists with status Submitted or Reviewed will be exported (others will be ignored).

• Export is limited to a single page of the table at a time — up to 10 checklists per export.
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Guest Space
Guest Space, Pre-check-in form and guest registration form configuration

We have added some new pages for property managers to set up and manage their Guest Space,

pre-check-in form and guest registration form for their offices.

The new pages can be accessed from the offices index page -> Actions -> Guest space & Guest

forms The Guest registration form is available here only for the offices where Activate direct

booking website guest registration form is enabled.
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Finance
1. New VAT flow setup available for Platform fees

You can now automatically calculate and apply VAT on OTA platform fees

Context: In some markets, OTA platform fee invoices are issued under the property manager’s VAT

number instead of the owner. VAT has to be paid by the property manager and consistently

charged back to owners. If not, it causes revenue leakage and reconciliation issues.

Now: A market-specific setup allows VAT to be correctly applied and recovered on OTA platform

fees.

To enable the feature, please contact your RentalReady account manager

Once enabled, the system automatically:

Calculates VAT on top of platform fees

Applies the VAT impact in owner and property manager splits

Generates platform fee invoices with VAT

Makes all invoices available to owners in the Owner Space

2. Agent Payout Statement Available in Agent Space

Agents can now download their payout documents directly from the Agent Space, making it easier

to track payments and keep records. 

Before: We've recently added the new Payout statement for agent - It was only available in the RR

staff user UI, under > Finance > Financial transactions table.

Now: Agents can now also view and download their payout statement ! 

Path: Agent Space > Missions statements > Statement column > Payout statement

The new document appears below the existing mission statement document.

Document name: “Payout statement”

----Important notes The Missions statements page is not available on mobile. Agents must use

a desktop browser.
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3. Agent split KYC - Add business type selection (company/individual) for agent connected

accounts

Before: Only “company” option was allowed by default for the Agent’s stripe account.

Agent connected accounts are currently created with business_type set to company by default.

This means Stripe requests company-specific documents during KYC verification (CRN, VAT

registration, etc.).

This blocks agents who are sole traders or self-employed individuals, as they don’t have these

documents. For example, sole traders in the UK use a UTR instead of a CRN and are typically not

VAT-registered.

Now: It is possible to select the Company/Individual business type for the agent stripe account.

It is mandatory when split is enabled for the agent.

4. Triple split logic update: agent split now based on mission earnings

Before

Agent payments in the triple/agent split were based on the invoiced cleaning fee only => and

only cleaning missions were considered
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If the mission was done and the agent was eligible, the full invoiced cleaning fee was paid to

the agent

For mid-term reservations, payment happened on the first split only, even if new missions were

added later

Extra missions added after the first split or differences between mission earnings and invoiced

fee were not handled

Now

Agent payments are more accurate and fair, calculated based on mission earnings. All mission

types are included: Cleaning, Check-in, Check-out, Extras. 

How it works ?

If a mission is done, not canceled, and the agent is eligible, the split uses mission earnings, not

the total invoiced cleaning fee

For mid-term reservations, splits happen on every split, supporting cases when new missions

are added later

In the final split, PM_CLEANING receives: Invoiced cleaning fee – total mission earnings

already paid to agents.

Important notes 

If total mission earnings for a split are higher than the invoiced cleaning fee, the split will fail

If a mission is split but later canceled, nothing changes automatically for now

Misconfigurations may surface faster, so review agent eligibility carefully

Technical notes 

Split calculation now relies on mission-level earnings instead of invoiced cleaning fees-level

amounts.

Added validation to prevent overpaying agents beyond the invoiced cleaning fee.

Logic applies to both short-term and mid-term reservations.

Tested for the last 2 weeks 

5. Triple split goes global: GBP Agents split is live! 

Agents can now get paid in both GBP and EUR currencies automatically, making payouts faster and

simpler than ever!

Before

Only EUR agents could receive automated splits.

Stripe bank accounts were created using IBAN only.

Now

GBP agents can now get automated splits!

The Agent form has new fields:

Bank account currency
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Bank account number

Sort code / routing number

How it works ?

EUR agents continue using IBAN

GBP agents use account number + sort code for Stripe setup.

Important notes

Bank fields are not mandatory, but without them:

No Stripe account is created

KYC cannot be completed

Payouts will be stuck

Works the same way as the Owner bank account setup.

Technical notes

Stripe account creation now adapts to currency: EUR → IBAN, GBP → account + sort code.

KYC and validation rules remain the same.

Access

Update agent bank info in RR: Users > Agents > select agent > Edit > Payment info

6. Agent split - Payment Status at Mission level updates automatically

Before: The Payment Status  on Edit mission had to be always updated manually.Splits to agents did

not change the status.

Now: When a split to an agent happens, the mission is automatically marked as Paid 

Important notes

Only missions linked to a split are updated

Missions already marked as Paid remain unchanged
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7. Agent split KYC - Add business type selection (company/individual) for agent connected

accounts

Before: Only “company” option was allowed by default for the Agent’s stripe account.

Agent connected accounts are currently created with business_type set to company by default.

This means Stripe requests company-specific documents during KYC verification (CRN, VAT

registration, etc.).

This blocks agents who are sole traders or self-employed individuals, as they don’t have these

documents. For example, sole traders in the UK use a UTR instead of a CRN and are typically not

VAT-registered.

Now: It is possible to select the Company/Individual business type for the agent stripe account.

It is mandatory when split is enabled for the agent.

8. Agent split toggle - remove PM-level split_allowed check

Removed the Property Manager split_allowed check from the agent form

Before: The Enable payment split input was disabled if Property Manager had not split allowed.

Now: We dont disable the input anymore if PM has no split allowed. This allows to enable split for

agent for PM that has some offices allowed for split and some not.

9. Owner commission calculation option 

We introduces a new option to calculate Owner commission / earnings  

Before: Until now, commission calculations in RR only assumed Property Manager commission.

Now: You can choose how commissions are calculated:

Property Manager commission (status quo)

Owner commission/earnings 
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This choice is available at both office and property level.The system will apply the commission

formula to the selected option.PM earnings are calculated accordingly if Owner commission is

selected.

Important notes

Selecting a commission type is mandatory when setting up or updating a property/office.

If Property Manager commission is selected, behavior remains unchanged.

If Owner commission is selected, the system calculates owner earnings using the formula,

and adjusts PM earnings as needed.

Variables:

newly added: owner_vat_rate (see release below) ; extra_fees

renamed: commission_rate  to --> property_manager_commission_rate

to have owner_commission_rate , use --> (1 - property_manager_commission_rate )

RentalReady Apps
1. Weekly Mission View: Now on RR Staff App!

We are excited to announce that the Weekly Mission View has officially arrived on the RR Staff App!

Managing your schedule on the go has never been easier.

What’s New on Your Homepage?

Missions Overview: A brand-new mission bar has been added to your Overview/Homepage,

showing you exactly what’s on the agenda for today at a glance.

Instant Access: Simply tap on the mission bar, and you’ll be instantly redirected to the full

Weekly Mission View.
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2. Weekly mission view - Mobile Performance Improvements

We’ve shipped performance enhancements to make mobile data loading faster and lighter on

memory.

Missions now load by day (instead of loading the full week at once), which improves speed and

reduces memory usage.

When switching tabs, you’ll see a loading indicator only for tabs you visit for the first time.

Previously visited tabs now use cached data for a smoother experience.

Date Picker Fix (Small Screens)We also fixed the date picker behavior on small screens.

The date picker now correctly displays the current day you’re viewing.

3. New release of RentalReady PMS app (iOS) - 25/02/2026

We’ve resolved an issue on the app which caused it to crash when a user tried to upload photos

or videos
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RentalReady API
Rental Tags Now Available in the API

We’ve added support for Rental Tags to the API, making it easier to organize and filter your

properties.

View your account’s tags via the API

You can now retrieve the list of tags for the account.

Tags included in rental data

When fetching rentals, each property now includes its associated tags id.

Filter rentals by tag

You can now filter your rentals to return only properties that match one or more selected

tags.

Important Notes

Tags are specific to your account and cannot be accessed across different accounts.

Tag creation and management (add/edit/delete) continue to be handled in the tags dashboard.

Examples:

1. View Your Tags

GET /api/v3/tags/

Example Response:

{

  "count": 3,

  "results": [

    { "id": 1, "name": "Long-Term", "color": "blue" },

    { "id": 2, "name": "Mid-Term", "color": "green" },

    { "id": 3, "name": "Short-Term", "color": "orange" }

  ]

}

2. Rentals Now Include Tags

GET /api/v3/rentals/123456/

Example Response:

{

  "id": 123456,

  "name": "My Property",

  ...

  "tags": [1, 3]

}
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3. Filter Rentals by Tag

GET /api/v3/rentals/?tags=3

4. Filter by multiple tags (returns rentals with ANY of them)

GET /api/v3/rentals/?tags=1&tags=2
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